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Overview

This lab will show you how to develop applications running on a System z Mainframe system.
You will define a remote z/OS connection, set up a MVS project, remote edit, compile and
debug.

The lab can be divided into the following main tasks:

1. Initial preparation for RDz remote development

2. Working with remote programs

3. Compiling/linking/executing the remote program
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Lab Details

Description | Value | Comment
Local
RDz Install path C:\Program Files\IBM\SDP70
Appserver Path C:\Program
Files\IBM\WebSphere\AppServer
Host general
Userid USER## TSO user
Password javaws
Hostname / IP 192.168.7.xx xx varies from 71 to 84
JES Port 9715 JES Job Monitor
MVS / USS Port 4039 Remote RSE Daemon
Remote Connection Profile HostProfile
User’s home directory /uluser## USS home directory
User’'s HLQ USER##

Prepared Workshop Files
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Dataset prefix for prepared ARNOLD
code
Workshop files /local/zoaws

App Development Paths and Libs

Java home directories

/usr/lpp/java/d1.4
/usr/Ilpp/java/d1.5

Java 1.4.2 SR6 31 Bit
Java 1.5.0 SR2 31 Bit

Link Libraries for COBOL
Compile

SYS1.SCEELKED

Debug Library HLQ

SYS1.DEBUG.V710

Developer for z Library

SYS1.RD4Z.V750

CICS Properties

CICS USS install directory

/usr/lpp/cicsts/cicsts32

CICS user directory /u/cicsts/cicsts32

CICS var directory /var/cicsts/

CICS prefix cicsts32

CICS sit CICSTS32.CICS1.SYSIN(CICSH)

CICS Load Library

CICSTS32.CICS1.SAMPLE.LOAD

Additional Link Library for

SYS1.CICS.V320.SDFHLOAD

CICS Compile
Catalog Manager SYS1.CICS.V320.SDFHSAMP
CICS Applid CICS1
CICS Debug port 9876
CICS Web Service port 3602
CICS ADM port 81
Property Groups

Batch CICS IMS
COBOL batchCobol75 CICSCobol75
PLI
C/ C++
Assembler

General Hints: Everybody will get a different userid, distinguished by numbers. In your lab
guide this individual number is represented by ##. Please always substitute ## by your

number.
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1 Initial preparation for RDz remote development

Before we can start programming some preparations have to be done.

First you will connect to a remote system which has been set up for you. You will learn how
to organize your data using filters and how to allocate data sets using RDz. You will also use
the workbench to submit JCL which will setup all required data for this workshop.
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1.1 Define and connect to a remote system

The RSE's Remote Systems view shows all existing connections to remote systems.
Connections are System Connection objects that are persisted, containing the information
needed to access a particular remote host. The view contains a prompt to create new
connections, and pop-up menu actions to rename, copy, delete, and reorder existing
connections.

Connections contain attributes, or data, that is saved between sessions of the workbench.
These attributes are the connection name, the remote system's host name and system type,
an optional description, and a user Id that is used by default by each subordinate subsystem,
at connection time. Underneath, all connections are stored as files in an Eclipse project
named RemoteSystemsConnections, which the user can enable for team support, allowing
connections to be shared by a team.

1. If Rational Developer for System z (RDz) is not already up and running, start it. When
prompted for a workspace location you can either continue using a workspace from a
previous lab or create a new workspace.

& Workspace Launcher x|
Select a workspace

IEM Rational Developer for System z stores your projects in a folder called a workspace,

Choose a workspace folder to use for this session.

Warkspace: | C:'\Documents and SettingsAdministrator \IBMYrationalsdp?. Sworkspace j Browse... |

[ Use this as the default and do not ask again

oK I Cancel

2. If you created a new workspace a welcome screen will be displayed that you will have to
close.

3. Ensure you are working with the z/OS perspective by selecting Window > Open
Perspective > Other... and select z/OS Projects.

4. Click on the Remote Systems View and expand the New Connection node, right-click on
z/OS... and select New Connection to open the pop-up menu.

Y |- z/05 Projects

fﬂﬁ Remote Systems &4 S Teamw =8
£ 2] | =R

-2 New Connection

“El Local ...
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If this is the first time that you have attempted to create a connection in RSE, you are
prompted to create a profile before you can create the new connection. Name your

profile HostProfile and Click Next.
If the screen does not appear there are already existing profiles and you can ignore this

step.

Hame personal profile
IUniguely name user profile :H:

Welcome to Remote Systems. Connections can be sharable by the
team ar private to you, Enter a profile name to uniquely identify you
from your team members. You will decide for each new connection
whether it is owned by the team profile or your profile.

Profile: | HostProfile

(7) = Back I Mext = I Eirishi Cancel

In the Parent profile field, the profile named after your workstation appears by default (Note
that after you create the connection, you can share this profile to allow other users to have

this connection in their RSE perspective).

8/10/2009 RDz Remote COBOL Development

Page 7 of 79



© Copyright IBM Corporation 2008. All rights reserved.

7.

In the Connection name field, type a unique name to identify your connection in the
Remote Systems view called

demomvs.

The label that you assign to this connection will help you to differentiate between
multiple connections to the same type of remote system.

In the Host name field, type

192.168.7.xx

as hostname or IP address of the z/OS system that you installed the RSE server on.
Optionally in the Description field, provide a short description of the z/OS system that
you want to connect to.

To verify that the hostname or IP address in the Host name field is valid, select the
Verify host name check box.

=10l |

Remote z/05 System Connection

Define connection information

Parentprofile:  |L3Kxv58-1351C71 =]

Host name: |192.168.7.XX I j

Connection name: I demomyvs

Description: | connection to demo host

¥ verify host name

(7) = Back || Mext = | Finizh I Cancel

Click Next to continue.
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8. Inthe USS Files window we will also use the Remote daemon. Use 4039 as port. Note
that authentication will be via userid/password.

Corrrere AEX|
z/0S UNIX Files

Define subsystem information

Indicate how the remote server should be launched by default
(%) Remote daemon

Daemon Port {1-65535) (4039 | Authentication method |useridfpassword EI

(O REXEC

Path toinstalled server om fhosk

| astore |

Server launch cammand | . [Server, zzeries | Faort (1-A5535]

Buto-detect 551

IJse 551 for network communications
O Connect to running server

IUse 551 for network communications
O ssH

Path to installed server on host

astare |

Server launch command | . =erver zzeries | Port | 22 |
Password authentication
Key authentication
@) <Back [|[ mext> || mnsh || cancel
8/10/2009 RDz Remote COBOL Development
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9. For the MVS files, enter 4039 as Remote

Daemon port.

@ Mew Connection

B (=1%

MVS Files

Define subsystem information

(%) Remote daemon

Daemon Port {1-65535)

(O REXEC

Path toinstalled server om hosk
Server launch command

{:} Connect to running server

(O ssH

Path to installed server on host

Server launch command

Indicate how the remote server should be launched by default

Authentication method |useridfpass'.f'.'|:|r-:| [V]

Port {1-65535)

Prark

[ < Back

l l

][ Next = ] Finish ”_ Cancel

10. Click Next.

Note: If you have errors during the connection

creation it is because the z/OS system name

is not correct or not available (since you specified verify the host name on the step above).
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11. In the JES Job Monitor Port field, insert
9715
as the port on which the Remote Job Monitor is listening.
In the “Max Number of Lines to Download” field, type the number of lines to download
before prompting you to specify if you want to download all of the lines in the dataset.
We will accept the default of
5000.

=10 x|

JES

Define subsystem information

JES Job Monitor Port (1-65535) |9715|

Max Mumber of Lines to Download (1-2147483547) | 5000

(71 < Back Mt = | Einish I Cancel

Wi

12. Click Finish to create the new z/OS connection and add it to the RSE perspective.

13. If network to the to z/OS is available, you will have the connection created as shown
below:

fﬁﬁ Remote Systems &3 G Team] = O
£ 2] | | BF Y
El_tff Mew Connection

B Local ...

-,

E’ L-:u:all

ﬂ. demomvs

8/10/2009 RDz Remote COBOL Development

Page 11 of 79



© Copyright IBM Corporation 2008. All rights reserved.

14. Expand demomvs to see the sub categories of your remote system.

o

‘:H:T.Teamw =8
|25

#ﬁﬁ Remote Systems &4
4 2] |

B New Connection

: ----- Bl Lol ...

- ﬂ.. z05 ...

B Local

=
-y 2j05 UNIX Files
-3 2/05 UNIX Shells
- By Ms Files

------ G T30 Commands

-G JES

15. Now connect to your system by right-clicking demomvs and selecting “connect” from the

context menu.

16. You will be prompted for your z/OS userid and password.

Type the assigned userid and password.

Click on Save user ID and Save password. You will be automatically connected at later

times.
Click OK to connect to MVS Files subsystem.

X

O Enter Password

System type: zj0S

Host name:  192.168.7.xx
UserID:  |USER##
Passyword: | javaws

- Sawve user ID
[~ save pazsword

oK Cancel

17. Since RDz Version 7.5 you can secure your connection using SSL. If this has not been
done you will be informed by the following message dialog. Click Yes

18.

3

anyway?

[ Do not show this message again

Connection 192. 163, 7. 226 has not been secured using S5L. Proceed

If you successfully connect to the remote system, the demomvs icon changes to

8 demomvs (note the little green arrow).

8/10/2009
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1.2 Work with MVS files

At this point you are ready to start working with the z/OS assets.
We will see how to allocate new PDS (Partition Data Set), copy members and use filters to
display data.

19. Expand MVS files.

ﬁ_ﬁﬁ Remote Systems &9 L= Teamw =)
£ 2] | BF Y
_iff Mew Connection
E’ Local
=

BT 2/OS UNIX Files
-5 2/05 UNIX Shels
BBy MVS Files

o E‘* T30 Commands
=5 Es

*

+1
20. Click on [E]5% My Data Sets 14 gee your data sets.

Don’t worry if there are several data sets allocated, we will refresh the system later in this
chapter.

22. Use the drop down list to select your High Level qualifier “USER##” and type the data
set name JCL to allocate a data set that will contain our JCL members later on.

0 New Data Set _ O] x|

Allocate PDS
Allocate a new PDS residing on z/05. .3
Host Short Mame:

Iu:lemu:umvs j
Data Set Mame:

Juserm | x| fac

(7) = Back Mext = | | Einish I Cancel

23. Click Next.
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24. Select Specify characteristics by usage. Choose “SOURCE” for category and “JCL” for
type and click “Next”.

Data Set Allocation
Choose category andfor type, 'j

Data Set Mame: ZUSER.10,JCL

" Copy characteristics from an existing data set:

| Browse. .., |

¥ specify characteristics by uzage type:

Category |SOURCE =]

Type  |acL =]

" sSpecify characteristics {Advanced allocation).

Einish Cancel

This is a nice feature since it allocates a data set that has the characteristics necessary for
holding JCL.
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25. Note the default values and click Finish.

_ ol xI
Data Set Characteristics =
Specify data set characteristics for the new PDS or sequential file, 'j

Data Set Mame: ZIUSER10,1CL

Yolume Serial: |
Generic Unit: |
Space Units: |sLocks =]

Primary Quantity: I 200

Secondary Quantity: I 100

Directory Blocks: I 20

Record Format: IFB j
Record Length: | a0

Block Size: | a

Data Set Type: |L1ERARY (PDSE) =]

Expiration Date: |

System Managed Storage... |

(7] = Back | ext =

Cancel |

26. If space is available in the z/OS, this Data set will be created. If you do not see it, just
right-click on MVS Files and select Refresh.

(1% Remote Systems % Wi .
4 o | 2 | B 5

Elﬂﬁ demomyvs

"=¢ IES

=¥ MVS Files

- B3 My Data Sets (USER##.")

[ USER##.JCL |

We will now create a filter to access our master data set ARNOLD.JCL and copy a member
from there to our own JCL data set USER##.JCL. You already met a MVS filter when you
expanded “My Data Sets” earlier in this lab. This is the default filter to display all data sets of
the user currently connected to the system.

27. Right-click MVS-Files and select New > Filter from the context menu.
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28. Specify “ARNOLD.JCL” as Filter string and click “Next”. Be aware that this is a master
dataset, not your own. Please use exactly the name stated in the script here.

=10] %]
Filter | 1
Create a new filter ;_V;
1
Filter string:
ARNOLD.JCL

(7) = Back | Mexk = | Einishi I Cancel

29. Specify a filter name (e.g. “lab_materials”) and click Finish.

-0l x|
Filter -’1
Mame the new filter &
#’TV

Filters are saved for easy re-use, Specify a unique name for this filter, This name will appear in the Remote
Systems view, and will be expandable,

Filter name: lab_materials

¥ only create filter in this connection

Select a profile o awn Ehe new filker, This determines i ik is unigue ta you, of sharable by Bhe teanm, I6 wil
be placed in the default fiter pool Far that prafile,

Select the profile whose default Filker poal is bo contain the new flker: ILEIC?{'T'QS- 1951CZ1 j

(7) < Back | Next > | Finish I Cancel |

The filter should appear in your Remote Systems View.

i T
H remote Systems 52 G Teamw =8
S 2] | A =
=ﬁ Mew Connection
E' Local
El‘iﬁ demomvs

-5 2/05 UNIX Files
-5 2/05 UNIX Shels

=-*h MyS Files

. B3P My Data Sets (ZUSER10,%)

il y
ERE~—¥|5h_materials

----- L My Search Queries

-5 JES
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Note (you don’t have to do this now), that after creation you could specify more filter criteria
by right-clicking your filter and selecting Properties. You could create other filters like HLQ.*,
HLQ.*.COBOL, HLQ.UTIL.*, HLQ.*.COB*, etc... (where HLQ is your high level qualifier)
Using this mechanism you can easily structure your workspace by for example displaying
only the datasets required for a certain project using multiple filter criteria.

The following picture shows an example for a filter used in a COBOL programming project for
a high level qualifier called HLQ:

4§ Properties for cobol_project -0 x|
| type filter text Filter Strings - .
Filter Information Filter name: cobol_project
i Filter Strings .
{ Parent filter pool: Hostprofile Filter Pool

Refactoring History

Filter strings:
Mew filter string New filter string:
HLQ,COBOL
HLQ.JCL Filter string:

HLQ.COPYLIB I |

(7 OK, | Cancel |

30. Expand the filter and navigate to the member RDZALLOC.jcl. Copy this member to your
own JCL dataset you created.
You can do this by right clicking the member and selecting Copy.
Then right click USER##.JCL and click Paste.
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1.3 Adjust the editor

The default profile used by the LPEX editor is Ipex, which defines the key behavior. The
LPEX editor can emulate most of the key behavior of other editors like ISPF and XEDIT.

31.

Open the Preferences dialog (Windows - Preferences) and select LPEX Editor from
the left. Do not close the window yet.

O Preferences =10 %]
| LPEX Editor CRE N
" Java EE il Editor profile
[#- Javascript -
-- JET Transformations Elr'lg:s
- IPA —om
-~ Jython ot e
[+ LPEX Editor Ipex
-- Menu Manager SI'_E"'
[¥]- MFS Editor o it
&~ Modeling
-- Plug-in Development
- Remote C/C++ [ Disable parsing
Remote Synchronization
-- Remote Systems LI Reset | Restore Defaults | Apply |
(7) 0K I Cancel |

You now are able to enter prefix commands in the prefix area, such as d to delete, m to
move, etc... like you ma be used to from ISPF.

8/10/2009
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32.

Creating Tabs for the Editor

Since we are using COBOL is a good idea to create some TABS for easy navigation in
the editor.

Expand LPEX Editor, click on Tabs and enter 1 8 12 as Tab stops. Also change the Tab
increment to 4 (instead of 8). Each time Tab key is pressed will move the cursor to
positions 1, 8 and 12. The increment 4 will also make stops at 14, 16, 20, and so on.

O Preferences 10O x|
| Tabs S - -

E[ LPEX Editor | -
: Tab stops 1312

- Appearance
- Blodk Tab increment
- Compare
- Controls

- Find Text
[+ Parsers J
- Print

- Bave

H- System z LPFX Editor
- Tabs
- Lser Actions
- User Commands LI Reset | Festore Defaults | Apply

I¥ Display tab characters expanded

11 L Aok

.:':7:. QK I Cancel
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33. Go to General > Compare/ Patch and check “Ignore white spaces”. We need this
feature later for code comparison.

@ preferences

Compare/Patch

[=- zeneral = = I
[#- Appearance e =l |IE}'EJE Compare |
- Capabilities W Qpen structure compare automatically
- umpareatch [ Show structure compare in Qutline view when possible
- Content Types
- Editors [~ show additional compare information in the status line
- Errar Reporting bossoon v Ignore white space
- Keys
+]- Metwork C tion:
[] P:rs\;?arcﬁv:nec ) [T Automatically save dirty editors before browsing patches
- Search
- Security Enter regular expressions used to identify added or removed lines in a patch
- Startup and Shutday (e.g. "“\+\s™\5' for an added line with at least one word character).
- \Web Browser Addedlines I
[+~ Workspace
- Agent Contraller Removed lines |
- Ant
- Auto Camment
ey Enter member names that should be exduded from 'Compare With Each Other'.
- Backward C tibilit
e i el List is comma separated (e.g. '*.dass, .project, bin/)
- Bidirectional Developmer
[#- BMS Map Editor Filtered Members: |
M. COROH o
4 il | »
(7 oK I Cancel

34. Click Apply and then OK to save your changes.
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1.4 Use JES (Job Entry System)

With RDz you can edit Job Control Language, submit jobs to JES and review the output all in
one development environment.
We will now modify and submit JCL to z/OS to allocate some datasets that are required for

this lab.

1.4.1 Explore some editor options

We will first use your JCL source to demonstrate some editor features. Those features apply
to other sources than JCL as well, use them later if you find them appropriate.

35.
36.

Double click on the copied RDZALLOC.jcl to open it.

You can use the mouse to expand the editor area to see more lines of the COBOL

program. Also remember that when double clicking in the title (RDZALLOC.jcl) you can
either make a full screen or return to original size. Also Window - Reset Perspective
returns to the default.

37.

Change xxxxx to your z/OS userid (USER##) using Ctrl + F and clicking Replace all.

fﬂ RDZALLOC.jd &3

000001
000002
000003 /i
0oo0004g /7=
000005 /7=
000006 /7=
0ooooT S
000008 /=
goooos /i
000010 /=
1|

SETUP JOB FOR WDz wv6.01
NEEDED FOR THE Z/035
CHLNGE 'XHHEXX"'

Eind| | 3000

Mextl F'reiin:-usl Elll

Replace |USER##

Replace || Replace all iI

™ Case sensitive [~ Whole word [~ Regular expression W Wrap [T Select found text Peek: IJ'
[ Restrict search to selection [~ Restrict search to columns Stark calumn I 1 End columm IED

8/10/2009
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38. Hit Ctrl + L and enter 2 to navigate to line number 2.

fﬂ RDZALLOC.jd &3 = 5|

Line 2 Column 1 In=zert

B --+---—- 1 - I - A YR
000001 X¥XXXY JOB , i’
000002 // MSGCLASS=H, TIME=(, 4) , REGION=28M, COND= (16, LT)
Qoooo3 S /=
gopggo=s /= SETUF JOB FOR WDz wv&.01 POT
Q00oos ;s /=

=

J | o
Line number: | ]

39. Add a JCL error, for example if you delete the first comma in this line and press enter
this will have the error below.

i ™y
] *RDZALLOC.jd 53 =0
Line 1 Column 1 Insert 1 change
B --+---—- R e R e St 4o S————t—-
oooooi| UsER## =, i’

000002 I-IS;:—-’::LSE=I—Z? IME={(,4) ,REGICN=28MH, CCND=(1&,LT)
goeaox Tnexpected character =0,

0oopoz s /=

pgoopgo4 f/* SETUP JOE FOR WDz w&.01 POT

-
1| | 5

I a

40. Fix the line.
Either type the comma or hit Ctrl+Z to undo your change.

41. Save the changes (Ctrl + S). Note that the * that is beside of the title goes away.

42. Have a look at the Outline View where the structure of your code is displayed. You can
click within that view to navigate through your code.

r i Y
= Properties | o= Qutline &2 = 0

- J/DELIST EXEC PGM=IDCAMS
-+ [{ALLOC EXEC PGM=IEFBR 14,COND =(4,LT)
=) (JCOPY EXEC PGM=IEBCOPY,COND=(4,LT)
‘. [/SYSIN DD *

8/10/2009 RDz Remote COBOL Development
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43. You could have a situation where you need to see hexadecimal contents of the fields
(Common when doing assembler). Right-click and select Source - Hex edit line. You
will have the result below:

i Ty
B] RDZALLOC.jd &3 = B
Line 2 Column 14 Insert
R —— e P ;T F - -
00000l USER##  Jo= i’
000002 MS5GCLASS5=H, TIME=(,4) , REGION=28M, COND=(1&, LT)
000003 /-
goooos //* SETUP JOB FOR WDz w6.01 POT
000005 /7=
Q000006 |/ /* WEEDED FOR THE Z/05 LLE EXERCISES -
1| | _"l_l
Text | HSEC:LSS=I-ZL TIME=|(,4) ,REGICH=228M,CCOHND=(1&,LT)
Unicode FEDDJQdDDESDDQTjj 3004c004100530053003d0048002e
MmWEenmdMQCpHEEpf2f254d5547454c4155555d452c54494d455d252c54292
&mmeenmdthMﬁ?IELELQdeEECTCSdSCLEEEETECEEEESCQdQCETEQdEbeEdE

44. Right-Click

in any place in the editor area and select View - Open new view. This is

similar to the ISPF split screen. Sometimes this can be useful. Remember that double

clicking in t

45. Right-Click

he title gives you a full screen and much more work space.

again in any place in the editor area and select View - Horizontal split. This

is another option. Also see other options like Next View and Previous view.

46. To return to the default view, use Right-Click inside of the second view and select View
- Close View
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47. One nice feature of RDz is the capability to recover previous versions using the local
workstation. This is very useful when you delete and save components on the z/OS
where undo is not possible.

Right click within the code and select “Replace with - Local History” from the context
menu. It will show all the previous versions (probably you have just one).

=" Compare 1ol x|
[RemoteSystemsTempFilesFttRemoteTempFiles /demamys ZUSER 10/ZUSER 10, JCL/RDZALLOC jel EII‘;' | H]
Revision Time =

# 12/18/08 11:32 AM
B 12/18/08 11:32 AM o
B 12/18/03 11:31 &M

= o -
4| | b

=] Text Compare ,fb % "f'!'.i i)
i®] Workspace File | | B Local History (12/18/08 11:32 AM)
|//ZUSER1D  JOB , —//EHEEX JOB , | =
-

S MSGECLASS=H,TIME=(,4), REGICHN=28M, CC ff MSGCLASS5=H, TIME=(,4) ,BEGION=28

/4% BETUFP JOBE FCOR WDz w&6.01 POT //* BETUF JOB FOR WDz w6.01 FPOCT

f /% HNEEDED FOR THE Z/05 LRB EXERCI S /% HNEEDED FOR THE Z/05 LR EX

faf il CHRWGE 'ZUSER10' TO YOUR MVS T35 A CHRWGE 'ZUSER10' TO YCOUR MV

f/f* BIEF: DELIST //% STEPF: DELIST

/S/* DE-RLLOCARTE DATASETS MWEEDED FCR fi* DE-RLLOCATE DATASETS NEEDED

i (FRIOR TO ALLOCATING THEM IN THEH A (PRICR TO ALLOCATING THEM IN _I

F i o R R o A o . il

1l | L ] i

@ Replace I Cancel |

48. As we do not want to undo our changes, press Esc to dismiss the dialog.

1.4.2 Submit JCL and review output
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49. Submit this job by typing “sub” into the command line

Line 1

000001
000002

<]

000003 7/
000004 /
000005 7/
000006 /7
0ooaoT /S
0Qo0aos 7/
0ooaos 7/
000010 7/
000011 7/

fﬂ RDZALLOC.jd &3

Column 14

s e [ B

USER##  7CE

M3ECLASS=H, TIME=(,

r

f* SETUF JOB FOR WO

* HNEEDED FOR THE Z

= CHENGE 'USER##

P LR R

TR

= DE-LZLLCCATE DATL

IsuH

Fl

50. Note that you could also right-click the member or within the editor and select “submit”
from the context menu.

51. If the Job is not submitted and you get the message Job Monitor not connected to
system as shown below, It is because your JES subsystem is not connected

S rDZALLOC.jd X

1

Line 8 Column 48 Insert

J e i L
000001 - USER## JOE ,
000002 MSGCLASS=H, TIME={,4), REGICHN=28M, COND= (1
Q0oooo3 /=
Qgoooo4 //~ SETUP JOB FOR WDz v&.01 PBOT
QOoo0os /=
0ooooe //* MWEEDED FOR THE Z/05 LAR EXERCISES
QoooooT /= CHANGE 'USER0O1" TO YOUOR MVS USER ID
DOOOOE [/ % s AR R R R R AR AR R R R

The Job Monitor server iz not connected.

52. Use the Remote Systems view, locate the note JES under demomvs and Right-click on
JES and select Connect.
Try to submit again.
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o

53. If submit succeeded you will see the JOB ID that was created for this execution

= B
Line 1 Column 14 Inzert
B e ot et - L
000001 USER##  JoE i’
ooooo2 MSGECLASS=H, TIME=(, 4) , REGION=28M, COND=(16,LT)
gooooz [/ /=
gopggog /= SETUER JOB FOR WDz we.01 POT
00o0oos /7=
Qgoooos / /= MNEEDED FOR THE Z/05 LAR EXERCISES
oooooT /= CHLNGE 'USER## ' To YOUR MVS TUSER ID
OOOOOE /%  #os s s s s e e r dr AR AR AR AR AR R R R R R AR AR AR AR AR AR AR AR RE
Qgoooos f /= STEEF: DELIST
goooiag /=
goooll /% DE-ALLOCLTE DATASETS WEEDED FOR BOT
-
J | o
JOBID: JOB03203
[

54. Go back to the Remote Systems view and under JES node (must expand demomvs),
right click on the “My Jobs” filter and select Refresh (You can also select the filter and
hit the F5 key

55. Expand the listing and you will see something like:

G Teamw = 8|
£z - o W EE
=ﬁ Mew Connection
E' Local
= &ﬁ demomvs

- ‘E}j’ 205 UNTX Files
= szS NI Shells

t} TS0 Cn:-mmands
=& s

El}—:b My Jobs
&% zuser10:10803203
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56. Double click on first listing and be sure that the job has successfully executed and has
the return code is 4, 0 and 0 as shown below: (note could all zeros if you had datasets
allocated already). If you receive higher return codes contact your lab instructor.

r@ RDZALLOC.jd ( JOBO3203.0ut E3 =5
JES2 JOB LOG -- 5YSTEM 5Y51 fﬂ

JOBO3203 ———— THURSDLY, 18 DEC 2008 ———
JOBO3203 IRROL0I  USERID ZUSER10 IS ASSIGNED TC THIS JOB.
JOB03203 ICHT0001I ZUSER10 LAST RCCESS AT 14:24:44 ON THU
JOB03203 SHASP3TS ZUSERLO STARTED - INIT 6 - CLASS & -
JOE03203 IEF403I ZUSERLO - STRRTED - TIME=14.24.45%
JOBO3203 -
JOB03203 -JOBMAME STEPNAME PROCSTER nc | EXCE  COMN
JOBO3203 -ZUSER10 DELIST 04 43 22 =
JOBO3203 -ZUSER10 ALLOC 00 o =
JOBO3203 -ZUSERLO COPY 00 220 264 =
JOB03203 IEF404I ZUSERLO - ENDED - TIME=14.24.46
JOE03203 -ZUSERL0 ENDED. NAME- TOTAL
JOE03203 SHASP39S ZUSER1O  ENDED
152 JOB STATISTICS —————o
2008 JOB EXECUTICN DATE

130 (CARDS RELD hl
Kl | LIJ

You just submitted a JOB that was executed in the z/OS and allocated some data sets that

you will need for this lab.

57. Close the editors that are opened and the JES2 JOB LOG.

To display your submitted jobs in a more “SDSF-like” format, you can do the following:

58. Right-click either the JES icon or any job filter and select “Show in Table” from the

context menu.

z
Jﬁ Remote Systems &3 G- Teamw

:E-\

s

<oy
|

a| B ® ¥

- New Connection
E_.i) Local
Elﬂﬁ demomvs
- T 2jOS UNIX Files
-G 2/0S UNIX Shells
- *y MVS Files
E‘t T30 Commands
= Es
B2

]
7l Mew
Go Into
GoTo

E Open in Mew Window

Refresh

F&
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59. The “Remote System Details” View displays your Jobs and corresponding Information in
a table.

'E Remote System Details X z/05 File System Mapping | Remate Error IJst| Froblems | Console | Remote Shell | Remote
Job Filter My Jobs

MName | b0 | Jobmame | Job Owner | User return ... | Return Info | Return Status | Job Class |
%EZUSEF‘.II:JDBDBBDE JOBOS8B06 | ZUSER11 ZIUSER.11 Q0o NORMAL COMPLETIOM A

60. You can purge the output of jobs listed.
To purge Go to the Remote System view, Right-click on your Job ID and select Purge.
Alternatively you can purge the job as well from the Remote Systems Details table.

61. Using the Remote Systems view, right click on your “My Data Sets” filter and select
Refresh (alternatively select the filter and hit F5).

62. Expand My Data Sets clicking on the + and you should now have all the required
datasets for the next exercise ready.

JES job filters are used to define the search that is done in JES for jobs. JES job filter search
parameters include the following: Job Owner, Job Prefix, Job Output Class, Job Status and
Job Class, comparable to SDSF. You can use * as a wildcard character.

The filter “My Jobs” you just used has been created for you by default. To create a new filter
(you don’t have to do this now), right-click the JES node and select New > New JES Job
Filter...

TGRS L

® 2 - eBs Y
=&f‘3 Mew Connection
E) Local
Elaﬁ demomys

BT 2/05 UNIX Files
52 205 UNIX Shells
*hy MVS Files

O

Go Into
Go To L

E Open in Mew Window
R show in Table
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You can define several criteria to limit the jobs displayed. For a later exercise use the prefix
GEN* as Job Name Prefix, hit Next and give this filter a name like generated.

_ 1ol x|
New JES Job Filter -’1
Create a JES Job Filter by entring strings. Use = for wildcard i_L_:F

1

Job Owner:
| asERID

Job Mame Prefix:
| GENF

Job Status:

Job Class:

Job Qutput Class:

(7 = Back I Mext = I Finish Cancel
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1.5 Explore USS

63. To display the built-in USS File Filters, expand USS Files. The three built-in USS filters
are My Home, Home, and Root. Expand My Home to see the contents of your home
directory.

Note: The My Home filter displays your home directory. The Home filter displays the directory
containing your home directory. For most systems this will be /u’, but this may vary from
system to system. The Root filter displays file starting with the file system root (i.e. /’). If you
want additional filters, you could right-click ‘USS Files’ and from the context menu, select
Add Filter. Note that like the other filters, you can specify multiple criteria by right-clicking the
filter, and from the context menu, selecting Change or Properties...In future lab exercises,
we will be working with your home directory. Since there is a built-in filter to display the
contents of your home directory, we will not need to add any USS File Filters for the
upcoming lab exercises.

8/10/2009 RDz Remote COBOL Development

Page 30 of 79



© Copyright IBM Corporation 2008. All rights reserved.

1.6 Optional - Explore TSO Commands

This is an optional exercise.

If you are interested, you can explore the TSO Commands feature of RDz

Users can launch TSO session from Remote Systems view, they could have multiple TSO
Sessions up at the same time. The New TSO Commands Ul is based on USS Shells by
RSE. Let’s see one example below.

Using the z/OS projects view and Remote System perspective, be sure that you are connect
to the z/OS. If not connected, right-click on demomvs and select connect.

64. Scroll down to see the TSO Commands note. Right Click on it and select > Launch
TSO as seen below:

Kﬂﬁ Remote Systems &3 S Teamw = H)
& & | JE[E =
- Mew Connection
E_? Local
Elﬂﬁ demomvs
E- T 208 UNIX Files
-5 2/05 UNIX Shels
- *F MVS Files
=G ES & | Refresh F5
Disconnect

Zlear Fassword

hr

Host Connection Emulator

Properties Alt+Enter

65. The Remote shell view will open

= 0
€3 Remote Error List (H* z/05 File System M (_L:ﬁ')i Property Group Ma (,ﬁﬁ Remote System Det H’ﬂ\ SErvers (@ Remote Shell &3 =8
SOW P EE T
Specify a TS50 command to run
4| | 3
Command d LI
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66. You will be able to execute commands, like the command time seen below:
((E] Remaote Error List (H‘ z/05 File System M (_L:ﬁ':; Property Grouhﬂla (Jﬁ Remote System Det (-5?-!: SErvers

= O

AOE @R Y

B TS0 -demomvsl

Specify a TS50 command to run

B cime
IEJS6650I TIME-04:48:02 PM. CPU-00:00:00 BERVICE-295 SESSICH-00:00:00 DECEMBER 18, 2(

<]

|

Command

Also in the command line you will be able to use the Ctrl + Space to have the content

67.
assist, as seen below. Type | and press Ctrl + Space and select LISTALC:
% Remote Errar List (H’ z/05 File System M ﬂ%':; Property Group Ma ﬂﬁ Remote System Det (4!?4: Servers W
U =
ﬁ T‘SCI-demamvs]
Specify a TS0 command o rnn
B oocne | EILNK DISPLAY ACTIVE DATA SETS.
IEJSER: EILIST EMBER 18,21
|2 L1sTALE
[EL1sTRC
[EsTeaT
[Z/1sTDS
KN 2
‘)'
Command IEl ;I ;I
68. The result will the one below
F Remote Error List (H‘ 205 File System M (_Fﬁ':; Property Group Ma (ﬁg Remaote System Det (-5?4- Servers M—E |
S GBI E Y
] TSO-demomvs]
Specify a T30 command to run -
B cime
I¥J56650T TIME-0O4:48:02 PM. CPFU-00:00:00 SERVICE-295 SESSICN-00:00:00 DECEMBER 18
B -LISTALC
NULLFILE
Jtmp/ZUSERL10.IDOST071.I5PF.5YSTSERT
SYS1.5I5PMENT
SY51.5I5FTENT
SYS1.5I5FFENT -
4| | Ll_l
Command ;I ;I
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69. You also can use the icons below and perform some activities..

nﬁ Remote System Det | &L Servers @ Remote Shell &3 =0
(=] ;g =] | =

“““““““ 5 SESSION-00:00:00 DECEMBER 18

70. Right click on your remote project or anywhere within your demomvs remote
connection. Select Host Connection Emulator Support from the context menu.
You will be connected to z/OS.

71. Resize the window so you will be able to better see the 3270 black screen. Just Double-
click on the blue title demomvs.hce

72. Depending on the demosystem you use your screen will look similar to

dEMmomys., NcE

Current host connection profile is: HostConnectPrajectFiles [demomvs. hce

LR R R
* Boeblingen TMCOC

* z/05 1.7.0

* Enter an epplicetion name or a VIAM LOEF0ON command.

* Example: TS50 userid or LOEON APPLID(applid)

o o e Al e kel ol ol ol o et o o e e o ol ol e e ol ol ol ol ol e e e e o e o ol ol e ol ol ol ol ol ol o e o e o o e o e e e

- TSQ/E (T50Mn for LOGON with Model n=2, 3 4, 5]

IPADDR: 152 _1&68.17
PORT =

FF1 | PF2 | PF3 | Bt | PF3 | PFo | Enter | PAl |
PF7 | PF8 | PF3 | PF10 | PF11 | PF12 | Clear | PA2 |
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73. Note that all PF keys are represented by buttons. Of course you can also use your
keyboard. The default keys in addition to the PF keys are:
[Clear] — Esc
[Enter] — Return or Ctrl key
You can change those keys via Window - Preferences (from the menu bar) and then
expanding General and selecting Keys.

74. For example to assign the Pause key to the [Clear] command as used in IBM Personal
Communications select the [clear]-command, put the cursor to the Binding field, then hit
Pause and at last hit Apply (which is not shown in the picture).

Preferences

ae filter text
||-- GENEra | =
[#- Appearance Scheme: IDEfauIt j
- Capabilities
El- Compare [Patch ftype filter text
- Content Typeg
[+ Editors Command + | Binding | When
- Error Repgfrting [attr]
_ [bidilayer] Ctrl -+ In Host Connec
[#]- Metwork .Cnnnechcuns I [dear] I — In Windows
- Perspectives Tenter]
. Search
Earu:. [eraseenf]
- Security [erasefid]
- Startup and Shutdown )
- \Web Browser [E”'-'Ff]
[+~ Workspace [newling]
|- Agent Controller [pa1]
|- &nt [pa2]
- Auto Comment ekl
- Backward Compatibility
- Bidirectional Development Copy Command Linbind Command Restore Command
|-BMS Map Editor
|- COBOL Marme: [dear]
~ Lonnections Description: Conflic
|- Crystal Reports
|- Data Management ; Comr
g Hit Pause key to enter data
|- Ecore Diagram ,
|- Enterprise Service Tools .
sinding:  [[Pausel | 4]
- File Manager = - I ause] ¥
I Help When: IIn Windows j
|- Importer
|- InstallUpdate
|- Java
|- Java EE |

75. Click OK to save your changes and exit.

76. You can now optionally follow the screen instructions to logon to TSO (usually done by
typing “TSO” and hitting [Enter]). Use your z/OS assigned user id USER##. Do not
forget to logoff properly before closing the emulator.
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2 Work with remote files

Working in eclipse is traditionally realized with projects. For z/OS this means that you will link
your assets into a project structure: into z/OS projects. These projects can have USS or MVS
subprojects, depending on whether you want to work with files residing in USS or members
in MVS. In both cases your assets stay on the host and are only logically linked into sub
projects.

By associating Property Groups with those sub projects you can bring your members or files
into a context with compile, link and execution properties.

This chapter will guide you through the process of creating a remote project and setting its
properties for different languages and runtimes.
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2.1 Retrieve and import property group

Property Groups are a new feature of RDz 7.5. They contain the definitions for the z/OS
Projects to specify build properties.

In earlier versions, properties needed to be defined for each project (respectively subproject)
separately. Now all properties are kept separately and managed in so-called Property
Groups which are associated with a remote connection. They can easily be imported,
exported, copied, modified and associated with projects or members.

We will import the Property Groups for our lab which are stored in a XML file on the host. We
will drag and drop this file from our remote system (USS) into a local project and import it.

77. Open the Navigator View by selecting Window - Show View - Other... Expand
General and choose Navigator. Move the Navigator View if you like it in another
position.

78. Create a new general project by selecting File > New - Project and then General >
Project. Name it “localFiles”. This project is just a place to store our local files.

79. Go to the Remote Systems View and expand USS files and Root. Navigate to
/local/zoaws/props (this is a directory on your demomvs, not local on your PC!)

80. Select remoteProps75.xml and drag and drop it into your localFiles project in the
Navigator View (Note: this will only work with the Navigator View).

81. To ease your search for this file in the file system later, we will copy the location. Right
click your properties file and select Properties. Mark the path specified for Location, right
click and select Copy to copy the path.

Info - -

Path: NocalFiles batchCaobal, xmil
Type: File (XML)
Location:

Size: 9964 bytes nd

Last modified: Movember 21, 2007 11 “UE

I Read only

Now our properties file is available and ready to import.

82. To import the Property Groups, locate the Property Group Manager View at the lower
panel group, rightclick on demomvs and select Import from the context menu.

— =
¥ Remote Error List (“b z/05 File System Mapping (-L_':.". Property Group Manager &4 ﬂﬁ Remot:

MName | Description |

LOCAL MNew Property Group... |

83. Now either paste the content of your clipboard to the file destination field or use the
browse option to locate the file.
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84. Check ALL Property Groups and click OK.

© Import Property Groups -0l x|
File: | sral\ocalFiles \propsremoteProps 75, xml  Browse... |
MName | Description

remoteCICSCobol  CICS 3.2 Cobal on zHero System
remoteCobol 75 batch Cobol on zHero System

(7) Ok I Cancel

You now see the property group as child of the remote system connection.
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2.2 Create an remote project
85. Select File > New - Project... from the menu bar

86. Scroll down, Expand z/OS, select z/OS Project and click Next
E _ I DIEI
Select a wizard

_"\1{-'

Create a new 205 project

Wizards:

Itype filter text

- Web A
BH-{= Workstation COBOL or PL/T
El[E:- zj05

----- Bﬁ Database Application Project

----- M8 MYS Subproject

‘[E z/05 Project j

H-[= Examples

[ show All Wizards.

(7} < Back

Eimish Cancel
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87.

z/0S Project Hame

Create a /05 Project

On the New z/OS Project panel, name the project “hostProject” and select the “Do not
create a subproject now” radio button.

0 New z/0S Project

Project name: | hostProject

Subproject
Do you also want to create a subproject now?
i~ Create an MVS subproject

" Create a USS subproject

¥ Do not create a subpraject now

= Back [ExE =

Cancel |

88. Click Finish. This will create a z/OS parent project.

We will now create an MVS sub project.

89. You can define the MVS project only when you are connected to the system. Make sure
you are connected in your Remote Systems view.

90. Go to the z/OS Projects View, right-click hostProject that you just created and select
New > MVS Subproject from the context menu.

91. Depending on which lab you are going to work on check the Property Group with the
name in the following table:

Batch CICS IMS

COBOL batchCobol75 CICSCobol75

PLI

C/ C++

Assembler

Table 1 - available Property Groups for different languages and runtimes
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92. Name your MVS sub project like the name of the Property Group (the screenshot shows
an example) and select your userid as high level qualifier. Click Finish.

£ New MVS Subproject -0l x|

MVS Subproject Name and Location MU5
Create an MVS Subproject ﬁ

Host Short Mame: IzHen:u

Lef L

Project Mame: Ihu:ustP'ru:ujeu:t

subproject Name:|[batchCobol75

L

Subproject Type: IM'-.-'S

Lo

High-Level Qualifier: IUSER##

Select a property group to assodate with the new subproject.

Marne | Description | Mew...
-] eHeroBatchCobolProps batch Cobol on zHero System
-.[] remoteCICSCobal CICS 3,2 Cobal on zHero System Edit... |
I batchCobol75 batch Cobol on zHero System I

Cancel |

93. You should see an MVS Project in your z/OS Projects view. If you click on the + sign to
expand the project, you'll see that is empty.

We will review the imported properties later.

This lab will continue with batch COBOL programming to demonstrate more RDz features
and functions. Please look at Table 1 - available Property Groups for different languages and
runtimes - to see which other languages and runtimes are currently available for this
workshop. Please contact your lab administrator to receive other lab material.
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3 COBOL

In this chapter you will learn how to work with remote Cobol in batch. You already defined an
MVS project and imported the property group — now we will have a more detailed look at the
Property Group itself.

You will start with a very simple HelloWorld program (mostly generated) that you will edit,
compile, link and run. Later on you can have a look at some more complex programs for
debugging and other features like dependency check.
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3.1 Verify project properties
Before you start to work with remote COBOL programs let’s have a look at the property
group you already associated with your remote MVS subproject.

94. In the Property Manager Group, expand the remote System demomvs, then Right-click
your batchCobol75 property group and select Edit.

95. At first a short overview about the title and a description is given, click next to go to the
next parameters

O edit Property Group o =] o

Edit Property Group Information

Edit information for property group batchCaobol 75

~Property group
Name: |batchCobol75

Description: |

System: | demomys

(7) = Back Mext = | Finish I Cancel
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96. The next panel offers you to select the property you want to set. This is one of the major
improvements of the new version regarding the project property groups. Please verify
that the following options are ticked, then hit Next:

O Edit Property Group _ -0l x|

Select Properties for Property Group

Select the properties to be induded in the property group.

Property group batchCobol75

~Language
[~ Assembler Settings
¥ COBOL Settings
[ cjc++ Settings
[~ PLI Settings

~Screen Maps
[ BMS Settings
[T MFS Settings

Other
W 1CL Job Card and Data Set
V¥ Link Options

¥ Run-time Optiong

(?) <gack |iEis Y[ Ensh | cancel
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97. The COBOL Settings panel should be next, expand ELAXFCOC procedure, select
COBOL and click Edit Step....

=
Edit Properties in Property Group
Edit the properties in the property group

[.cosorsetwss | | coor settings

i JCL Job Card and C
i Link Options [ Use DE2 {contains EXEC SOL statements) ;I
. Run-time Options

[~ use CICs (contains EXEC CICS statements) ICICE

Procedure Mame | Step Mame | Status | Edit step...
ELAXFCOP Disabled
ELAXFCOT Disabled fdd skep,.. |
[HELAXFCOC Enabled
COBOL Remove step |
([} |
o |

Emable procedure

Disable procedure |
-

a ol I_*I_|

Cancel |

Note that we could enable and disable the procedures that must be executed before the
COBOL compilation done by ELAXFCOC if necessary. The default supplied procedures (but
disabled) are:

ELAXFCOP — invoke separate DB2 pre-compiler

ELAXFCOT — invoke separate CICS translator

But for this lab: do NOT invoke them.

By setting the checkmarks next to “Use DB2” or “Use CICS” you can invoke the integrated
translator. Also, do not check them because we are working in Batch.
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98. The COBOL Compile Step Options dialog will open. Review the settings. <HLQ> will be
replaced by the userid you specified during creation of your MVS project. Select OK to

confirm your changes.

O Cobol Compile Step Options

Compile Procedure Mame:

| ELAXFCOC

Compile Procedure Step Mame:

| cosoL
Compiler Options:

The ELAXFCOC procedure uses the
compiler option TEST(NOHOOK,SEP)
which will create a so called side file in
the USER##.COBOL.SYSDEBUG
data set. This file will be required later
at runtime by the IBM Debug Tool to
provide source code support.

Listing Output Data Set:

Debug Data Set: /
[<HLQ>.COBOL.SYSDEBUG kK
Ohiject Deck Data Set:

|<HLQ>.COBOL.OBJ

Copy Libraries:

Data set to place object

|<HLQ>.COBOL.COPYLIB

¥ Support Error Feedback
Data Set Qualifier for Compiler Errors:

Data set to search for copybooks

[<HLQ>.ERRCOB
Additional JCL:

jj======= ADDITIONAL JCL FOR COMPILE HERE ®*====

(7) 0K, I Cancel

=

o
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99. Select JCL Job Card and Data Set. <JOBNAME> will automatically be replaced by your
userid during submit.

© edit Property Group ;lglil

Edit Properties in Property Group

Edit the properties in the property group

¢ LOBOL Settings JCL Job Card and Data Set
“JCL Job Card and C

Link Options
i Run-time Options

1CL Job Card:

//<JOBNAME> JOB . Al
/f MSGCLASS =H,MSGLEVEL =(1, 1), TIME =(,4),REGION=70M, COND =(16,LT)

" o

JCL Data Set:
| <HLQ>.CcoBOL.JCL

Spedfy an existing data set to contain your generated JCL.

(7] < Back Mext =
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100. Select the Link Options. Expand the + besides ELAXFLNK, click on LINK and click on
Edit Step...

'_ﬂ Edit Property Group ;IEIEI

Edit Properties in Property Group

Edit the properties in the property group

- COBOL Settings Link ﬂpt'luns
JCL Job Card and Data =

Link Options

Run-time Options

I Procedures and Steps IJCL Substitution I

Procedure Mame | Step Mame Edit step...
(=] ELAXFLMK

M —

Remove step

i

(7) = Back MExk = | Einish I Cancel
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101. Adjust the link options to match the following picture and select OK to confirm your
changes.

 Link Step Options x|
Linkage Editor Procedure Mame:

| ELAXFLINK

Linkage Editor Procedure Step Mame:
f LIk

Link Options:

|

Link Libraries:

| <HLQ>.COBOL.OBJ

[ Append to:  Fosition,.. |

¥ Use spedfied link instructions:

All other required link libaries are set in
the ELAXFLNK proc

INCLUDE SYSLIB(EQADBCKT)

=
ki LIJ
Load Module Location:
| <HLQ>.COBOL.LOAD Data set to place load module

Additional JCL:
JpEE=wEEE ANOITIOMAL JCL FOR. LIMK HERE ===

g

':':’:' QK I Cancel
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102. Go to Run-time Options, expand ELAXFGO, click on RUN and click “Edit step...”
© edit Property Group _ O] x|

Edit Properties in Property Group

Edit the properties in the property group

COBOL Settings Run-time Dpt'lnns
ICL Job Card and Data =

Link Options
| Run-time Options |

Procedures and Steps | 1CL Substitution I

Procedure Mame | Step Mame Edit step...

[=] ELAXFGO
ErT— - |
Remove step |

(7) < Back Mesk | Finizh I Cancel
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1083. Make sure that “Run in Batch” — not “Run in Batch with Debugger” is selected. We will

debug later
) Run-time Step Options x|
" Run in batch with debugger
Run Procedure Name:
| ELAXFGO
Run Procedure Step Mame:
{RUN
Program Parameters:
|
Run-time Options:
|
Select the order of Run-time Qptions and Program Paramteters
¥ Program Parameters [ Run-time Options
i Run-time Options f Program Farameters
Additional JCL:
JF===EEE ADDITIOMNAL RUNTIME JCL HERE *==== ;I

o o

':?:' Ok I Cancel

You have now seen all properties of the group that we are going to use in the next steps. To

apply a property group we will associate it with a member, data set or project.
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3.2 Create a COBOL HelloWorld program using zZAPG
104. Select your COBOL dataset USER##.COBOL out of the z/OS Projects view.

105. Select File > New - Other.. and choose COBOL - Cobol Program.

Click Next.

106. Name your program and member HELLOW and place it in USER##.COBOL PDS.

& New COBOL Program

COBOL Program
Create a new COBOL program

Program Mame: I HELLOW

Authar: | USER##

rTarget
{% Partitioned Data Set
" Sequential Data Set
" Local file

—Partitioned Data Set
Location:

remoteCobol j
=

IBM-037
| USER##.COBOL

Host Code Page

Data Set name:

Browse,..

Member: | HELLOW

[T allocate FDS if new

¥ add comments to generated program

¥ Cpen Snippets view when finished

[ext = | Einish I

2] < Back

Cancel

Click Next.
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107. On the next panel you can specify features that will add code to your new program. Do
not select any, but click on the “Define Features” button to have a look how a feature

could look like.
O new COBOL Program - Ol x|

COBOL Program Features
Specify features that will be used in the COBOL program, | C

Which features would you like to add to the program?

O use M5 Maps

O 1nvoke CICS commands

D Use SO statements

[ Handle 5GL error return codes

Define features, ..

3 {CBadk ] wews [ Emsh | concel

108. If you click on a feature the tabs below will show you what code will be added at which
division or section. You could also create new or modify features here. Click Cancel to

dismiss the dialog.

i Preferences (Filtered) ;Igl ﬂ
| type filter text 5 | Features T T
= C:DBOL Choose and customize features available to COBOL programs.,
- Features

Features: {check to enable)

Use BMS Maps

Invoke CICS commands
7 fUse SOL statements
Handle SQL error return codes

Delete. ..

Rename...

I

En'uirnnmentl File Working Storage | Local Storage I Linkage I Procedure I

Statements to generate in this section:

e e
EXEC S5QL INCLUDE SQLCA END-EXEC.

il
4| | i

Restore Defaults | Apply

(7 0K, I Cancel

109. Click Finish and your program will be created. The editor opens automatically. A basic
skeleton was created for you.
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110. The preferences for this skeleton have been defined for your workspace. Click Window
- Preferences and navigate to COBOL - Code Templates and you will see what led to
creation of your program. You could use these templates to spread coding guidelines for
example.

D preferences o ]
ftype filter text Code Templates = -
- General o
__ Agent Controller || Configure Generated Code and Comments:
- Ant - Comments Edit... |
- Auto Comment - Copybook Comment
- Backward Compatibility - Program Comment
- Bidirectional Development --Data Division Comment Import... |
[ BMS Map Editor - Environment Division Comment
- COBOL - 1d Division Comment Export...
. - Code Templates - Procedure Division Comment |
Export All...
{ -Features [l- Code
- Connections - Copybook
- Crystal Reports
-- Data Management - Data Division
[ Ecore Diagram --Environment Division
-- Enterprise Service Tools - ID Divigion
- File Manager - Procedure Division
- Help
-- Importer
-- InstallUpdate
- Java I Enable BiDi Visual Editing
" Java EE | Pattern:
[#- Javascript
-- JET Transformations ${program comment} ﬂ
j:g_m ${id division}
‘ T S{env division}
[#-LPE¥ Editar T -
: £{data division}
[ Menu Manager — ..
--MFS Editor £i{proc division}
- Model Validation i
- Modeling K -
-- Plug-in Development
- Remote C/C++ Restore Defaults | Apply
i =
(7) Ok I Cancel |
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3.3 Add resources to your project

To make the new member available to your remote project, you will need to add it.

111. Locate your newly created member in your Remote Systems View and richt click it. (If
you don’t see your member, right click the filter or the corresponding data set and select
Refresh).

112. Select “Add to Subproject...” from the context menu.

113. Accept parent project name hostProject and sub project name batchCobol75 and click
Flmsh to add the member to the project.

(I _oix

Add Resources —

G
Add selected resources to subproject. ﬂ :
L)

Project Mame: Ihu:ustF'ru:ujeu:t j
=

Subproject Mame: IbatchCoboI75

Cancel |

114. Switch to the z/OS Projects view and you will see that USER##.COBOL has been
added to the batchCOBOL project. The z/OS Projects view should look like the
following:

1Ll 205 Projects 53 '?E.Nauigator\l = 0
E o

-,

= @ hostProject

=2 bbatchCobol75 [demomvs]
Hrcco Ei USER##.COBOL(HELLOW .cbl)

115. Before we can proceed, we might need to apply a Property Group, which is new to
version 7.5. Therefore right click the project batchCobol75 -> Property Group ->
Associate Property Group. Tick the property Group and then hit OK.

O Assodiate Property Group F - Ol x|

Property group

[Narme | Description I
----- [AbatchCobol75

':':’:' 8]4 I Cancel |
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3.4 Exploring the Editor

Code assist helps with the completion of code and is activated by pressing Ctrl + Space
when in the content area of the z/OS LPEX editor.

116. In your HELLOW program navigate to the empty line below PROCEDURE DIVISION.
Place your cursor in column 12 (B) (from beginning of the line hit TAB 2 times).

117. Due to the fact, that in Cobol the column in which the line of code starts is depending on
strict rules, you might enable a margin line. You might enable this in the preferences >
LPEX Editor > System z LPEX Editor > COBOL Parser
Tick the options like displayed and hit Apply and OK.

O Preferences O] x|
[tvpe filter text COBOL Parser - -
#.l..ltusave il ¥ Enable Margin & line at column &
B C/C++ Parser
- COBOL LPEY Editar ¥ Enable Margin B line at column 12
B COBOL Parser ¥ Enable Margin R line at column 73
- Controls

- Find Text %
[+ HLAsm Parser

The result are the following margins:

Kﬂ HELLOW.chl &3 =8

Line 11 Column 14 In=ert

000001 R R R R AR R R R R R R R OR R R R R R R ORROR R R R R OR R R R R R R R R R R R R R R R
000002 =
000003 =
000004 R R R R AR R R R R R R R OR R R R R R R ORROR R R R R OR R R R R R R R R R R R R R R R
000005
000006
000007
000008 ITDENTIFICATION DIVISICON.
000008 PROGEALM-TD. HELLOW.
000010 BITHOR. zuserll.

000011
000012
000013 ENVIRONMENT DIVISION.
000014
000015
000016 DATL) DIVISION.
000017
000018
000018 PROCEDURE DIVISION .
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118. Type “DI” and press Ctrl+Space. A window will show all suitable Cobol commands

starting with “DI”.
=&

Line 20 Column 14 In=ert 2 changes=
-———+-*2-1-5-f+ 2 3+ 4 4 5.

000019 PROCEDURE DIVISION . N

000020 DI

000021 w2 DISPLAY

foooz2 ¢ DIVIDE

0oooZ3 2% DIVIDE - NOT ON SIZE ERROR. - END-DIVIDE

000024 20 DIVIDE - OM SIZE ERROR - END-DIVIDE

___ 27 DIVIDE - ON SIZE ERROR. - NOT ON SIZE ERROR - END-DJ —

4 b

| 1| | 3

119. Press Enter to select the first one (DISPLAY) and insert the string “Hello World”.
120. Use Ctrl+ Enter to create a new line (like ISPF newLine command).

121. In the next line we want to write “STOP RUN.”, use content assist as well.
S HELLOW.chl X

Line 21 Column 18 Insert & ch
————+—wg—1—3——+——=—2————+————3————

000019 PROCEDURE DIVISION

000020 DISPLLY "Hello World™®

000021 STOF x|

000022 | =2 RUN

122. Explore the different code completion possibilities. Press the Esc key to dismiss the
popup list. For COBOL verbs that require additional parameters (identifier in COBOL
terminology), code assist will present data items defined in the working storage section
as selections in the pop up list.

Finally your PROCEDURE DIVISION should look like

PROCEDURE DIVISION
DISPLAY "Hello World"
STOP RUN.
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3.5 COBOL Syntax Checking

Before submitting a job to the z/OS system to compile the COBOL source file, you can
perform a syntax check to ensure a clean compile.
You will deliberately introduce an error to illustrate the error feedback facility.

Since the new version 7.5 a new real time syntax check is implemented. When you do a typo
a small exclamation mark is shown at the first column in front. This is inherited from the the
distributed application development within eclipse.

123. Overtype DISPLAY with DSPLAY (NOT DISPLAY) to force an error and save your
changes (CTRL + S).

124. You now see already the yellow small exclamation mark in front of the line. At the right
margin, please be aware of the small yellow-white flag. The margin represents the
whole document, and you have a overview of the errors and hints of the document.

1E]HHLDWJ$IEE =
Line 21 Column 51 Insert
———— A-1-B-——+-——- P ;T P — s@---+-——- 6———
000015 -]
000016 DATZ DIVISICON.
000017
000018
000019 PROCEDURE DIVISION .
& 000020 DSPLAY "Hello World"”
oooo21 STOP rumn.
-
4| | 3
|
125. Now hover over the exclamation mark at the left — a hint is displayed. You can as well
hover over the small flag at the right side of the editor.
ﬂE]HalDwJﬁlzz =
Line 20 Column 13 Insert
—_———— *L-1-B-+———— p TR Fmm - " SR P f——m—
000015 -]
000016 DATZ DIVISION.
000017
000018
000019 PROCEDURE DIVISION .
£ I'DISPLAY" expected instead of this input| Hello World™®
000021 S5TOP run.
-
1| | *
|
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126. If you do not like to have the real time syntax check activated, you might change the
settings for the Cobol Parser Settings in Window - Preferences - and in the
navigation tree LPEX Editor | System z LPEX Editor | Cobol LPEX Editor

O pPreferences

jcosoL By

EI Enterprize Service Tools

. COBOL XML Converters
El Service Flow Projects

: .. COBOL Requester T

EI Impl:urter

[} LPEX Editor

- System z LPEX, Editor
¢ - COBOL Parser
C\Workspaces\RDz 75

_ ol x|
COBOL LPEX Editor -

"Enable editor annotations and tooling” in order to receive real-time
syntax checking of COBOL files via warning annotations in the editor.
"Enable tooling only™ to disable editor annotations but leave the editor
actions in the context-menu enabled (e.g. "Open Dedaration”,
"Refactor”). Disable editor annotations and tooling” to disable both the
editor annotations and context-menu actions.

COBOL Parser Setting

¥ Epable editor annotations and toaling
" Enable tooling only
{” Disable editor annotations and tooling

The next steps describe the explicit local syntax check.

127. Right click anywhere within the code or right click on HELLOW.cbl in your z/OS Projects
View and select Syntax Check - Local.

128. In the dialog box specify that you want to do a syntax check only.
® Check Dependencies?

g You might want to chedk the dependencies before proceeding with the syntax

o/ check

™ Refresh dependendes and then perform a syntax check

o]

Cancel

Note: For a local syntax check local resources will be used. This means you can save CPU

by performing local tasks.
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129. The TPF Toolkit Console will provide Feedback about the compile process. It should
return a reason code of 12.

i — u
&£#| Remote Error List (H* £/05 File System Mapping (_":IE;'JI Property Group Manager (E Remote Console 23 JE

FrogramFiles=C: \Program Files

[TMP =C: \DOCUME ~ 1\ADMIMI~1\LOCALS ~ 1 Temp

EystemDrive=C:

ICLASSPATH=C:\Program Files\IEM\WebSphere MQJavaibicom.ibm.maims.jar; C:\Program Files\IBMYWebSphere MQY,
iZommonProgramFiles=C: \Program Files\Common Files

" OBPATH=C: \Program Files\IBM\SOP 705hared \pluging\com. ibm. Ftt. i, views. navigator_2.0,0.v2008 10101454
LAMG=en_LIS

[LSPATH=C: 'Program Files\IBM\SDP 75 \messages | 36l | 36

| OCPATH=C:'\Program Files\IBM\SDP 75 ocale

LY SLIE=

Output:

StdErr:

Return Code; 12

1 |

130. Click on Remote Error List view (in the bottom) to check compilation errors.

-,

ré;ﬁ Remot &4

| 2jOS Fq _L=$: F'rn:nperw El Remnt] 5 Remnt] &l Seruerw [ F'\emn:nt] (B2 Snippe\l =0

Filter matched 1 of 1 messages

R B R AT

| o

| Message

| SEVE... | Line

| Location

| Haost Mame

3 IGYPS2072  IGYPS2072-5 DSPLAY was invalid,.. 2 20 hostProjectfremoteCobal/,..  demomvs

131. Double click on the error message. This should bring you to the editor. Note that a red
mark was placed next to the error. If you use your mouse to hover over this mark the
error message is displayed again.

f@ HELLOW.chl 52 =0

Line 21 Column 13 Inzert

———— *L-1-Sl - R Fmm R e R fm—-
000015 -
000016 DATE DIVISICH.
000017
000018
0oools PROCEDURE DIVISIOHN

% IGYPS2072-5 "DSPLAY" was invalid. Skipped to the next [L4"
verb, period or procedure-name definition. "DISPLAY"
expected instead of this input -

1| | 3

132. Fix that returning the old version that had the correct DISPLAY statement..
Click CTRL + F4 or CRTL + w to close the editor..
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133. Perform another Syntax Check to ensure that the compilation is now clean. The error
message at the problems page must be gone.

réfa Remot &7 + 205 Fq _L=$: Pruperw = F'.emn::nt] oz | Remnt] ) Serverw [ F'.emn::nt] (B2 Snippe\l =0

-,

Filter matched 0 of 0 messages

R B R AT

| 1D | Message

| SEVE... | Line

| Location | Haost Mame

134. Close all opened editors if still opened. (CTRL + F4)

8/10/2009

Page 60 of 79

RDz Remote COBOL Development




© Copyright IBM Corporation 2008. All rights reserved.

3.6 Compile/link/execute the remote COBOL program

In this part you will learn how to compile your programs, link them and execute them on
z/OS.

3.6.1 Using Project Build

The Project Build Feature will build all Members contained in your project automatically. At
the moment, your whole Cobol dataset is contained in the project, so for this section we will
remove it and add the Cobol member only.

135. Go back to the “z/OS Projects” View, right click your remoteCOBOL subproject and
select “Rebuild Subproject” from the context menu. The result will look similar to

x@ z/OS Projects &3 . T Na'uigath =

E =

EI‘@. hostProject

- B batchCobol75 [demomvs]
|8 USER##.COBOL.SYSDEBUG(HELLOW)
1l USER##.COBOL(HELLOW).cbl

----- USER##.COBOL.LOAD(HELLOW).exe

‘.- |5§ \USER##.COBOL.OBJ(HELLOW).0bj

136. To run your project, right click your load module USER##.COBOL.LOAD(HELLOW).exe
and select “Run” application from the context menu. A popup window will inform you
that a job has been submitted. This job runs your load module.

: Xl

O 1ob submission confirmation

s

faae

i WZIDO0305I: 'JOB04062" has been submitted to host 'demomyvs’, Use JES on
the Remote Systems view to view its output.

137. To review the output go to the “Remote Systems” View and expand JES and an
appropriate filter (at least the “My Jobs” filter should display your results) to review your

job output.
'f 3 = o — -
[ Zuser11  E2 2 B || 48 remote Systems 52 Gl Tean'q B
Hello w _u'{f & | - | = | ﬂfp —
- T 2/05 UNIX Files a
5 2f05 UNDX shells

¥y MVS Files
b r';rf TS0 Commands

=g s
=5 My Jobs
% zUsER 11:]0B04052

=] JESZ:IESMSGLG
- JES2:JESICL b
2 JESYSMSG

- f---L GO:SYSOUT
Kl LIJ B d

FLISER 11 WORMA4ANA1

3.6.2 Using JCL Generation
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You will use a feature called JCL generation, where the properties of your Remote z/OS
project are used to generate JCL for Compile only, Compile and Link or Compile, Link and
Go.

We are using this feature for demonstration purposes. In real world of course you will either
use you company’s provided compilation procedures or take advantage of a source code
management system like SCLM or Endeavor.

Now that you have a successful syntax check of your COBOL program, you can generate the
JCL (Job Control Language) that will be used to create the executable on your z/OS system.

138. Using the z/OS projects View, Right-click on HELLOW.cbl and select Generate JCL -
For Compile Link Go.

139. On the JCL Data Set and Member Name window, notice that the JCL Data Set Name is
set to the value you specified for your project settings.

© 101 pata Set and Member Name x|

Job Mame: |USER##

JCL Data Set Mame: IUSER##.COBOL.JCL

Member Mame; | HELLOWY

(7) oK I Cancel |

140. Click OK. You should see the message below

l_ﬁ- L Generation Message

[x

\ij) WZID09131: Generated JCL is in the PDS 'ZUSER.11.COBOL.JCL'.

141. Go to your z/OS Projects view and you will see that HELLOW.jcl was generated.
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142. Submit your JCL (Right click > Submit), go to your Remote Systems View and expand

the Job under JES.

Elﬂﬁ demomvs
& ¥ 205 UNIX Files

-5 2/05 UNIX Shells
- ¥y MYS Files
----- El’r TS0 Commands
=& 1Es
-5 My Jobs
El:{=:=> generated
=%
----- 2| IEs2:IESMSGLG
b JES2:IESICL

-2 JES2:JESYSMSG

-] LKED:SYSPRINT
w2 GOSYSOUT

143. Double click on GO:SYSOUT to see the program output.
[ ZUSER11.GENU11.J0B04065.00000104.7 53

Bello World

3.6.3 Using Menu Manager
You can use a feature called Menu Manager to parameterize JCL with variables from your

workbench. Please refer to the separate Menu Manager Lab.
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3.7 Debugging Cobol

We will now have a look at a little more complex program and execute it in debug mode. The
member REGIOA.cbl has been copied to your Cobol dataset.
To execute in debug mode, we have 3 options:

e Modified property group for the JCL generator

e Right click menu of a load module within a MVS project

e Exits

144. Either create a new MVS subproject or empty your existing project (careful, don’t delete,
select “remove from subproject” from the right click context menu) and add REGIOA.

3.7.1 Some more editor goodies
As REGIOA is a little more complex we can explore some more editor functions.

145. Right click on the variable “FIELD-A” and select “Open Declaration”. The focus will jump
to the declaration.

fﬂ REGIDA.cbl #2 ™. 88 HELLOW.chl 1 = 5|
Line 37 Column 38 Insertc
—+—*A—1—3——+————2————+————3————+——=—&————+————5————
000030 -
000031 LINERGE SECTICH.
000032 PROCEDURE DIVISICH.
000033 D10-INITIALIZATICH.
000034 = Initialize Program-work- = v
000035 DISPLAY "Program REGIOR
000036 MOVE 2 TC BRANCHFLAG. Uk
000037 MOVE 'RARRAR' to FIELD-B  Copy
000038 MOVE 'BEBEBE' to FIELD-E  paste
0000359 MOVE '"CCCCCC' to FIELD-C
000040 MOVE "Enterprise Transfc Select
000041 MOVE "WSED - CUTPUI"™ to Selected
000042 HMCVE "REGIOB" to progran Leselect
000043 020-LOGIC. .
000044 CALL program—to—call TS  Herview
000045 move €6 to valuel. Shes 4l
000046 move 1 to received-from- SoUrce
000047 divide waluel BY receivw Refactor
_ DISPLAY "The zesult io - poempwE
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146. Mark the line saying

PERFORM 030-SEEYA
right click it and select “Open Perform Hierarchy”

-
=] REGIDA.cbl 52 ™. i) HELLOW.chl 1
Line 52 Column 37 Insert
————4—-*h-1-B-—4-——-2————F———-3-————4%-
000049 IF BRANCHFLAG > 1
000050 CALL 'REGIOC' USI
000051 DISPLAY "BRALNCHFL
000052 PERFOEM 030-5EEYR
000053 ELSE
000054 DISPLAY "BRALNCHFL
000055 FERFOEM 040-GOODE
000056 FOBACK.
000057 030-5SEEYA.
000058
000059 DISPLAY "PROGEAM IS EN
000060 040-F00DBYE .
ol

Save

Cut

Copy
Paste

Select
Selected
Deselect

Filter wiew
St &l

Source
Refactor
Open Dedaration

Open Perform Hierarchy

147. The Perform Hierarchy Window will open and the focus will jump to the declaration.

KE REGIOA.cbl 22 . 5] HELLOW.chl 1 = 0|
Line 57 Column 17 In=ert
~———+-*p-1-3--—+-B 5 4 3 4. &
000048 IF BRANCHFLAG > 1 ﬂ
000050 CALL '"REGIOC' USING Input-name
000051 DISPLAY "BRANCHFLAG GREATEER THAN 1"
000052 FERFOEM O30-5EEYA
000053 ELSE
000054 DISPLAY "BRAMNCHFLAG <= 1"
000055 FERFOEM 040-GOODEYE.
000056 GOBACE.
000057
000058
000058 DISPLAY "PROGEAM IS ENDING —-- SEEYA". -J
000060 040-F00DEYE.
-
J | s
|
r0{:: Perform &2 % Remote ] | zjOs Filew _L=L=;':-: Prupertﬂ U8 remote ] = Cnnsnle} U4 remote 1 = 8|

Statements performing '030-SEEYA' in ‘REGIOA.chl'

‘.. 58 020L0GIC

| Linel Perform Statement

g o3 ¥
I

= 57

148. Click on the lg *le buttons to toggle between Performer and Performee Hierarchy
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3.7.2 Modified property group for the JCL generator

Your generated JCL can be modified to initialize debugging. Instead of modifying the
parameters, we will create a second Property Group for Debugging.

149. Navigate to the Property Group Manager and right-click on the existing Property Group
batchCobol75 and select Copy...

150. Now right-click the new Property Group “Copy of batchCobol” and open the edit panels.
Before proceeding rename the Property Group to a more meaningful name like
batchCobol75 Debugging. Hit Next.

All Properties are now identical to the template. We now only modify the parameters for
debugging.

151. On the Run-time Options panel, expand the + next to ELAXFGO, select RUN and click
“Edit Step”.

© edit Property Group _' -0l x|

Edit Properties in Property Group

Edit the properties in the property group

¢ COBOL Setiings Run-time Options

-~ JCL Job Card and Data Set

-~ Link Options Proced = —

- Run-time Options iR LS | JCL substitution | |
Procedure Mame | Step Mame Edit step... II
=] ELAXFGO

E—T— |
Remove step |
Up |
Do |
4| | 1

(7) < Back Mext = | Einish I Cancel
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152. On the Step Options Panel, select “Run in batch with debugger” and make sure that
“Program Parameters / Run-time Options” is selected as order. Click OK. And then
Finish to save changes.

O Run-time Step Options _ x|

" Run in batch
= Run in batch with debugger

Run Procedure Mame:
| ELAXFGO

Run Procedure Step Mame:

{RUN

Program Parameters:

Run-time Qplions:

Select the order of Run-time Cptions and Program Paramteters
i Program Parameters [ Run-time Options

" Run-time Options / Program Parameters

Additional JCL:
jj======= ADDITIONAL RUNTIME JCL HERE ==w=== |

(7) Ok I Cancel

153. Now do a right click on REGIOA.cbl and select Property Group > Associate Property.
Select the Property Group you just prepared for Debugging:

O Assodiate Property Group 1Ol =|

Property group

Mame | Description I
----- [ batchCobal 75

g 4 | batchCobol 75-Debugging

§ 'E-:. (0] 4 I Cancel

154. To generate the JCL right click REGIOA.cbl and select Generate JCL - For Compile,
Link and Go.
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155. Open the generated JCL and scroll to the end of

the JCL to look at the runtime options.

RDz inserted a TEST runtime parameter specifying your IP address. This was done

because you asked for remote debugging in the

a Run-time Step Options

™ Run in batch

Run-time Step Options.

¥ Qun in batch with debugger

Run Procedure Mame:

| ELAXFGO

Run Procedure Step Mame:
{ RUN

Program Parameters:

Run-time Options:

Select the order of Run-time Options and Program FPar:
|F Program Parameters [ Run-time Options

i~ Run-time Cptions / Program Farameters

Additional JCL:

Jfeeeeee ADDITIONAL RUNTIME JCL HERE **==*=
"
[{#**wwxw® LDDITIONAL JCL FOR LINK HERE *% %+ f*
GO EXEC  PROC=ELAXFGO,GO=REGIOL,

LOADDSN=USERO1.LOAD,
PLRM.RUN=('/TEST(,,,T

ffFmsdkww AODTTIONAL RUNTIME JCL

CPIP&&1592.168.17.13%8001:%) ")
ERE o v e e e e

156. Submit the Job. After a moment, you are asked,
Perspective

You can now either cancel debugging to try the other

if you want to switch to the Debug

options or you can directly jump to

chapter “3.7 Debugging Cobol” on page 64 and try the other options later.

3.7.3 Right Click Menu

157. Initiate a project build on the project that you added REGIOA to. Your load member

should be available now (USER##.COBOL.LOA

D(REGI0A))

158. From your project, right click the load member and select “Debug Application” from the

context menu.

You can now either cancel debugging to try the other
debugging instructions and try the other options later.

3.7.4 User Exits
This feature is currently not available.

3.7.5 Using Menu Manager

options or you can directly jump to the
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You can use a feature called Menu Manager to parameterize JCL with variables from your
workbench. Please refer to the separate Menu Manager Lab.

3.7.6 Debug

159. The window below will ask if you want to switch to the Debug Perspective. Click Yes.

© Confirm Perspective Switch

suspends,

2

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpaoint

management.,

Do you want to open this perspective now?

[~ Remember my decision

This kind of launch is configured to open the Debug perspective when it

X]

Mo

160. Now the Debugger Perspective is opened and you will see the image below

=10l x|

FI|E Edit Mavigate Search Project Run Window Help

J f‘j J Ei?? %’|$Debug 331 Java r‘ﬂ Diata

J D - ﬁ -2 -Q- J 4 Fe- 2/05 Projects

= ae [l 8 = e -,

rﬁ? Debug 22 4l Seruers} = 8 (t0= yari 53 . S Erew A F'.eg\l [ Man\l &) Mad\l =
Db (| @ 8| B3R g ||| Name

| % & -
= E REGIDA [Remote Compiled Application]
Elﬁ:ﬁ' Platform: Q5/390(R) Connection: 192, 16¢
: Iél---.;u"EI Thread: 1 (Runnable )
"--= REGIOA : D1
“pl Process: 500232616 Program: REGIOA

4 |

& o local variables are available for the selected stackfra

| e

3 - milm
g BT
%F ZUSER 11.COBOL.SYSDEB 52 1 = O |[ 5= outline 2 - =
Line 1 Column 1 In; ﬂz||_=|é|| . 'Eg|§-v
_____ " S BHER) = OSSR TR ey Eey T B i Ees Tl
e i = £ PROGRAM: REGIOA
» 000001 IDENTIFICATION 4] ‘. IDENTIFICATION DIVISION.
gaaag. EROGhAM N . B - ENVIRONMENT DIVISION,
1] | » [+]- DATA DIVISION,

[#- PROCEDURE DIVISION,

161. Close the outline view that is not be useful in this debugger.
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162. Click twice on the icon Step Over = (or F6) located in the Debug view until you stop in

the DISPLAY command:

Note: If the icons are disabled, click on REGI01:01 under Thread:1

o "y
éw ﬁ? i il Seruers} = O ||e9= vari &2 ™ Erew i F‘.EQ\I C Mun\l ) Mud\l - =
% O P33 g 5| Neme
@ PROGRAM-WORK-FIELDS
% B ® CLOGRAMFLAGS
= E REGIOA [Remote Compiled Application] ® ERANCHFLAG
El;ﬁ' Platform: 05/390(R) Connection: 192, 16§
. El-pf® Thread: 1 (Runnable ) 4| | |
e \FGI0A : 01 =]
“e-pi] Process: 500232616 Program: REGIOA i
N — j | _*|_I
" Ty
18] REGIOA.jd ﬁ‘fr ZUSER 11.COBOL.5YSDEBUG(REGIOA).cob 53 - =
Line 35 Column 1 In=ert BErowse
e B et R
000034 = Initialize Program-work-fields, Program-flags, Alis
» 000035 DISPLAY "Program REGIOA STARTING ™
000036 MOVE 2 TO BRANCHFLAG.
000037 MOVE '"ARRAARRRA' tTo FIELD-A. =
000038 MOVE 'BEEEEE' to FIELD-E.
000035 MOVE 'CCCCCC' to FIELD-C.
000040 HCWVE "Enterprise Transformation POT " to Inputq.
Jl | _"I_I
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163. Double click to the left of line number 000040 to add a breakpoint. The symbol (| |'° f)
appears. Note that the breakpoint will also be added to the Breakpoints View (upper

right).
Kﬁ Debug &3 " dik Seruerﬂ = (9= var F‘.E;ﬂ 5 Mnrq &) Mod| = O]
S b o % ﬁ o h\
% b Mla-zae keS| [F].# Statement [ZUSER 11.COBCL.SYSOEBUG(REGIOA) |4l

% R
= fﬁ' REGIOA [Remote Compiled Application]
El;ﬂ Platform: 05/320(R) Connection: 192, 16
: El---.;.j'%I Thread: 1 (Runnable }
i = REGIOA : 01
“-pi| Process: 500232616 Program: REGIOA

1 | i I I >I
i = Ty
E REGIDA.jc (ﬁ* ZUSER 11.COBOL.5YSDEBUG({REGIOA) cob &8 =

Line 35 Column 1 Insert Browse
I———+—*A—i—3——+————2————+————3————+————ﬂ————+————5————+————E——-
000034 = ITnitialirze Program—work-fields, P:cg:am—f;agsr_:J
¥ 000035 DISFLAY "Program BEGIOA STARTING "
000036 MCVE 2 TO BRANCHFLAG.
Qooo037 MCOVE 'ARAARL' to FIELD-A. =
000038 MCVE 'BEBBEG' to FIELD-B.
aTaTalah-t=] MCOWVE. "CCCCCC' to FIELD-C.
@ 000040 MOVE "Enterprise Transformation POT " to Inputq{e
| | ;IJ

164. Click the Step Over button =* (or F6) twice.
Click on Variables view (Upper right) and you will then see the COBOL working-storage

data items.
.
= ari B Erew B F‘.eg} L= Mun} 5 Mod| — O
=
Mame | Yalue
® PROGRAM-WORK-FIELDS
® PROGRAM-FLAGS
® EpANCHFLAG 02
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165. Move the mouse to the field BRANCHFLAG and wait 3 seconds or doubleclick on it.
You will see the contents of this field. This is another way to see the variables

M
] REGIOA. jdl

000034
000035
000036
000037
000038
000039
® 000040

<]

Line 36

.
ﬁk ZUSER 11.COBOL. 5YSOEBUG(REGIOA).cob &3 =0
Column 35 Insertc Erowse
——t—*L-1-Be—to——— p J S e Rt e et F—m-

HOVE

"Enterprise

-

BCT

" to Input-,
| _>I_I

Transformation

|
166.

Move the mouse to the line 000042, Right-click and select Jump To Location

SLAl LIS iy Al 13 T LN IES

Viove The 1T
] REGIDA. jc

ob 3 = 0
Browse
————t———— g L s T 6——-
IFLac. N
FIELD-A.
FIELD-B.
FIELD-C.
Transformation POT " to _rp'_:t—-—I
FUTI" to Output-name.

1

= Add Breakpaint
m— Add Watch Breakpoint. ..
ikt  Jump To Location
® 000037  RunToLlocation k
Q000038 i i
000039 Maonitor Expression
@ goopag  Monitor Memaory »
000021  gyitch view >
':”:”:”:"&2 L pry o0 L e g L

program-to-call.

167. The program jumps from line 37 to 42 but did NOT execute the statements that were
jumped. This can be verified just moving the mouse to one of the fields like FIELD-B.
Also note that the breakpoint that you added did not work, since it was jumped.. See

below.
i = ™
EI REGIDA.jd ﬁ‘fv ZUSER 11.COBOL. SYSDEBUG(REGIOA). cob &3 &
Line 38 Column 39 In=ert Browse
———4- *h-1-B-—t———m P S Femm - Be----+-——- O f——-
HMOVE 2 TO BRANCHFLAG ;I
MOWVE 'RRZLRL' To FIELD-A.
MOVE 'BEEBEE' cto R,
HOVE "CCCoo =9 [FEDE ="rrrrri] - IS
@ MOVE "Enterprise Transformation POT "™ to Input
HMOVE "WSED - COUTPUT" to COutput-name.
> MOVE "REGIOB"™ to program—to-call. -
| _>I_I
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168. Click STEP INTO - (or F5) twice since we want to debug the Called program. After a
while, you should be inside of the program REGIOB as seen below:

"o co y
fﬁ*Debug & T Serversw = B ||69= vari 52 % Eirew i Reg\l E= Mnn\l 3] Mod| = OB
ke &3 2 g ||| Neme | value
® nECVD-PARMS
| % & -
Elufﬁ Platform: O5/390(R) Connection: 192.;'
: E---m@ Thread: 1 (Runnable )
G0 - 02 ‘| | 4
B = REGI0A: 01 ]
“pe| Process: 500232616 Program: REGIOA =
4| | b £l 3
' ™y
8] REGIOA.jd ﬁ‘fr USER01.COBOL. 5YSDEBUG(REGIOE).cob 532 Sam
Line 2 Column 1 In=sertc Browse
—— *R-1-B-—4———m P T F - - 6——-
000001 Identification Division. -
» 000002 Program-ID. "REGIOEB"™
B =~ PR e R R W
000004 * This program is called.
000005 o It returns a value (0)
000006 * This will cause an error when this value is used in
DOOGOT| = %% o o o R W R R R R R R R R R R R R R -
4| | _’I—I

169. Click STEP INTO =~ (or F5) again. As you see the program REGIOB just moves 0 to
In-value and returns. This value will be used in a division. And guess what? Division by

Zero will later cause an exceetion.
LELRLE LN o Lln-—waliue

000013
000014
000015
000016

QQoo17
aTalalab B=]

Gokack.

Pl 2E.

Procedure Division using Recwvd-Parms.
Move 0 to In-wvalue.

170. Now step over several time times until the cursor is positioned in line 46. We now want
to produce a division by zero and jump over line 46 without executing line 46, which sets
the RECEIVED-FROM-CALLED field again to 1. This is done only for the correctness of

this program for our other labs.

So position the curser to line 47 and hit Jump to Location from the context menu.

171. Just use resume P (F8) until you get the exception due the division by zero (0CB)
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172. Select Examine and click OK since you want to fix this problem:
@ Event Occurred

The following event has occurred:

CEE32115 The system detected a decimal-divide exception (System Completion  Code=0CE].

Select which action to take:
i~ Stepinto handler

X

& CEE32115 The system detected a dedmal-divide exception {System
\l‘) Completion  Code=0CB). Execution suspended while examining exception
from entry point REGIOA in program REGIOA at statement 47 at compile unit
offset O00005BE at address 10000966, Application environment and data
may be unstable or inconsistent.

174. Move the mouse to the line 45 (will need to scroll back) and press the left mouse button

to position the cursor there.

175. Now Right-click on line 45 and select Jump to Location, since we want to execute the
divide again. Depending on the version that you are using you might need to do that

twice.

176. You will be now on the line 45 as shown below

goo044 CLLL program-to-call TUSING received-from-calle
> 000045 | move €6 to valuel.
000046 move 1 to received-from-called
000047 divide waluel EY received-from-called GIVING :_t

AnAA AR LT ATVT RIT T e eem e e S = " —— ——

177. Now step over twice (F6), to get into line 47.
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178. Using the Variables view, expand PROGRAM-WORK-FIELDS, navigate to RECEIVED-
FROM-CALLED field and click on its value 01, since we executed the Move in line 46.

The value will become editable. You can change it to a desirable number; you also can
produce a division by zero.

=
(=)= yariables &3 g Breakpnints} it Registersw L Mu:unib:urs} 5] Mu:udules}

Mame | Value |
B ® PROGRAM-WORK-FIELDS

® [PUT-NAME 'Enterprise Transformation POT '

® oUTPUT-MAME "WSED - QUTPUT '

® PROGRAM-TO-CALL REGIOE
&, RECEIVED-FROM-CALLEL 01
® yuUE1 &6

=

=
()= yarighles &3 g Breakpnints} Bt Registersw L Mu:unib:urs} 5] Mu:udules}

Mame | Valle |
B ® PROGRAM-WORK-FIELDS

® [PUT-NAME 'Entgrprise Transformation POT '

® oUTPUT-NAME "WSED - QUTPUT '

® PROGRAM-TO-CALL REQIOE
&, RECEIVED-FROM-CALLEL MY
® yuUE1 &6

=

e

179. Depending of your modification, you might now correct it a second time, like described
in the last steps. If you have no division by zero, proceed with the next step.

180. Click STEP INTO - (or F5) until you see the next called program REGIOC being called

181. Click on Step Over ‘= (F6) and ¥ (F8) when you are satisfied so the program will
execute until the end and click OK.
© Debug Engine Message X

\i‘) Application has Terminated

182. Using the Remote Systems view locate the node demomvs and expand the JES node
and either the general filter “My Jobs” or the filter “generated” which has been created in
a previous step to specifically display your GEN* jobs.
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183. You will see the job that you had submitted as the example below. If your job does not
appear in the list, click on the filter and press F5 for a refresh.

e
W] REGIOA.jd &3 = O || 48 remote Systems 57 5% Teanﬂ
Line 20 Column 24 Insert ' %J|
————— PN Y-S : ,
g 3 BT 2/05 UNIX Files
ggggi;j“%” COBOL.COPYLIS, DISP=SHR = 3 205 Unnx shels
SER11.COBOL.COBYLIE, DISP=5HE : o
-y Mys Fil
000019 MY - ;D TsJo C'ES .
000020 SER11.COBOL (REGIOA), _ %E ammanzs
000021 =& s
000022 - My Jobs
B ted
000023 L. FOR COMPILE HERE #*%%ww% - S generate
N | > Bt | 10800224
— g | H H 5
JOBRID: boRooz224 ~ PoE JES2: JESMSGLG
[ . 5 JEsZ:IESICL

184. Expand the job clicking on the + sign and double click in the step GO, you can also see
all the steps of the submitted job

f@ REGIOA.jd f ZUSER 11,GENU1L,J0B00224, 53 > = O] ﬁuﬁ Remote Systems B2 %5 Tearﬂ
Frogram REGIOA STARTING =] & & |
The result is ... &6 ﬂ T50 Commands
Thanks to Enterprise Transformation Eltﬁ s
SRANCHFLAG GREATER THAN 1 -2 My Jobs
PROGRAM IS ENDING -- SEEYR \ B3 generated
=% GENU11:10B00224
----- |5 1ES2:IESMSGLG
-5 JES2IESICL
2 1ES52:3ESYSMSG
‘| | KED:SYSPRINT
_Ill =% GENU11:10B00217
1 I I 4 mﬂa (SRR 1= TTRANZ?1E

185. Close the editor (CTRL +F4)

186. Select the all your jobs (use CTRL key), right-click and select Purge. All job listing will
be purged if you have authorization for.
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3.8 Copybook expansion and dependency check

187. Add IGYTSALE.cbl to your batch Cobol project (this has been copied to your Cobol
dataset) and open it from there.

188. With the editing window of IGYTSALE.cbl active, press Cirl +F to bring up the
Find/Replace dialog (shown below). Enter copy in the Find field and click the All button.

Find | COPY

Mext

Replace |

Replace

Previous |

Replace all |

[T Case sensitive [ Whole word [~ Regular expression [V Wrap [ Select found text Peek: IEI 3:
" Restrict search to selection [~ Restrict search to columns Stark colummn I 1 End colummn ISEI

189. You should see something similar to the following. All lines with copy will be shown.

ﬁﬂ IGYTSALE.chl 53 = B8

Line 112 Column 31 Insert
—————— "B-1-B-—t————Z2-———t——— 3t 5 ¢

H -

S 000112 #%% Tnclude code (from copy library)

S 000113 Lkl IGYICRC - Copy member in IGY.V1RZMO.,S5IGYSLME

S 000115 Lkl IGYTFRC - C y member in IGY.V1IRZD EYSLME

S 000117 Lkl IGYTSRC - C r member in IGY.V1IRZMO.S5IGYSAME

B 000166 =#=% Q9T7Feb Show where copy files are located on

S 000216 I50500 Copy igytcrc.

S 000222 Copyv igvtprc.

S 000228 Copy igvtsrc.

S 003036 Copy igvtcrec. ||

S 003043 Copv igvtprc

S 003050 Copy igvtsrc

S 003360 Copy igvtcrec.

S 003365 Copy igvtcrec.
< |
Eind | COPY Next | Previous | |
Replace | Replace | Replace alll
[ Case sensitive [ Whole word [~ Regular expression W Wrap [ Select found text Peek: IG
[ Restrict search to selection [~ Restrict search to columns Stark colummn I_ End| columm SI:I

190. Highlight the copybook name igytcrc (line 216), press mouse button 2, and select the
Open Copy Member action.

v [PIVIVR N1 === Y/ rep SNOW WAere COopy I1Lle3 are LoCaTted On VH EENYZ /1Y
= | 000216150500 Copy HEpaasas
— nonzzz2 Copy igytprc.
== nnnz3 38 M drrrare
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191. A window will open and ask if you want to add this Data Set Member to your Project.

Click No

0 Open Copybook or Include Member

Do you want to add this Data Set Member to your Subproject?

192. This will open the igytcrc copybook in another editing window as shown below:

fﬂ IGYTSALE.chl (E] IGYTCRC.cpy 52 =8
Line 1 Column 1 Insert
—— A-1-B-—4-———- P S T F - - 6—-
OODOOlI 15 cust-record-type Fic x.
000002 15 cust-nunber Fic xx.
000003 15 cust-name EEC ®i20).

Note that the copybook is shown even that is NOT part our MVS Project. Usually there is no
sense to add copybook libraries to MVS projects, since they are used for many projects,

unless they also need updates.

Copybooks are resolved based on the value of Copy Libraries in the COBOL Settings for the
MVS project. The COBOL Settings of the property group of your remoteCOBOL MVS project

should look like the following figure:

& cobol Compile Step Options

Compile Procedure Mame:

| ELAXFCOC

Compile Procedure Step Mame:

| coBoL
Compiler Options:

Listing Output Data Set:

Debug Data Set:

[<HLQ>.COBOL.SYSDEBUG
Chiject Deck Data Set:

[<HLQ>.COBOL.OBJ
Copy Libraries:

|<HLQ>.COBOL.COPYLIB

Data set to search for copybooks

In this example, the copybook will be resolved (expanded) from USER##.COBOL.COPYLIB.
You can specify multiple copy libraries, each separated by a space. This is equivalent to
what on MVS is termed concatenation, in effect specifying the search order for copybook

resolution/expansion.

193. Close the IGYTCRC.cpy editor.
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194. Click anywhere on the IGYTSALE.cbl editor area to make it the active editor. Right click

and select the Show all action.

= 000112 #%% Include code (Erom copy library ﬂ
= 000113 = IGYTCRC - Copy member in IGY.V1IRZMO.SIGYSAME
= 00011% Save [GY.V1IRZ2HM0D . SIGYSAME
= 0oo117 [GY.V1IRZ2HMO . SIGYSAME
= 000166 1zl L iles are located on
= Qoo21e IS0500 Zopy ZhrlH-Imserk

=k 000222 Paste Ehrl 4

< Qooz22s8

% W oos03e Select g

- 003043 Selected 3

= 003050 Deselect AlE-HL

i gggz :g Filter view »

5 H aaaaen [ showal coiw |

This action removes the filtered view (currently showing all statements with the word copy)
and displays all statements.

RDz has a feature named Show dependencies that is useful when you need to identify which
components are required to compile the COBOL program. For example when working off-line
you will need to identify all dependencies that are necessary for a clean compilation.

195. Right-click on IGYTSALE.cbl in the z/OS Projects view and select Show Dependencies.

196. The COBOL compiler will be used to find the dependencies. You will see that this
program will need all the members listed below.

Show Dependencies

=10 x|

The following is the list of build dependencies [

The build dependencies for remoteCobal’

O zuUsER11.COBOL{IGYTSALE)

O zuUsER11.COBOL.COPYLIBIGYTCRE)
O zusER11.COBOL.COPYLIBIGYTPRC)
O zusER11.COBOL.COPYLIBIGYTSRC)

Select Al | Deselect Al

[T Add selected to subproject

(7) Finish I

Cancel |

197. Click on Finish to close this dialog. (Do not select any member)
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